Bool
T




The Daily NIV or K]V Readings

The Book View ButtonBar
ToolBar Buttons

Drag And Drop Buttons
MenuBar

ToolBox
Right Mouse Button Help

POPPPPPP e

3

5



e ol - L et SiaE T
T e

The Book View ButtonBar
ToolBar Buttons
The Almanac View
The Daily Reading Version
Indexes

Topical Index
¥ Biblical Index
Related Texts
Date Finder

Map Locator
NotTracker

»
S The Daily NIV or K]V Readings
&
VA

Po90 99

9
@ o
]
@‘E
SR
P
o
<
Q)
%
o

W

WORDMarker Search
WORDMarker Palette
Erase WORDMarker
File Open

File Save

Drag And Drop Buttons

®
@ MenuBar
e
®

P9

ToolBox
Right Mouse Button Help

B
- _ﬁrr.



The Daily NIV or K]V Readings

The Book View ButtonBar

ToolBar Buttons

Drag And Drop Button
Printer

Clipboard
MenuBar
ToolBox

Right Mouse Button Help

9o

kA
-O-‘-O-



0

kA
‘-O-

EPPPPH I

The Daily NIV or K]V Readings

The Book View ButtonBar
ToolBar Buttons

Drag And Drop Buttons
MenuBar

File
@ Windows
ToolBox

Right Mouse Button Help



Rool

lliei

@ The Almanac View
@ The Almanac View ButtonBar
S Almanac Buttons
»

MenuBar



sl

i

o
A

The Almanac View
» The Almanac View ButtonBar
] Almanac Buttons
¥ The Book View
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The Almanac View
The Almanac View ButtonBar
Almanac Buttons
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Almanac Button

The Almanac View gives you the opportunity to learn facts about Scripture such as
Chronology, Overviews of each kind of literature, Outlines, and Profiles of each book
of the Bible, and the Apocrypha. You can choose from twenty-nine different time
frames and view a parallel history of biblical and world periods.
To Open the Almanac View
% Select the Almanac View button from the ToolBar.
Or select View from the MenuBar and choose The Almanac.

Press ALT + A.

See Also:

Almanac Buttons
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The User's Guide provides you with "how to" information on all the tasks of OMBW.
You may jump from one topic to another with the click of the mouse. In any window
when your mouse pointer turns into a hand, press on the left mouse for added
information.
When you are using OMBW, help is only a keystroke away.
To Get Help

Press F1 or choose User's Guide from the MenuBar
To Use the Help Index

» Choose one of the following

4 Click an underlined topic

4 Press the TAB key until you highlight the topic you want, and then press the
ENTER key.

To Search For A Help Topic
1. From the Help menu choose Search
OR
From the Help menu choose Index
OR
Press F1
Choose Search and OMBW will display the Search dialog box.
3 Type the first few letters of the topic for which you desire to search.
4 Double-click on a keyword and more keywords are displayed in the bottom
box.
5 Double-click or press the Go To button and to display information on your
chosen topic.
To Return to the Previous Topic
4 Click the Search button or press the S key.
To Close the Help Window
» Choose Exit from the File Menu or press ALT + F + X.
To Scroll in the Help Window
Choose one of the following
4 Press the Scroll Bar UpArrow or DownArrow button.

» Move the Scroll Bar button up or down with the mouse.
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Almanac View Window
Biblical Book Index
Book Outline

Book Profile

BookMark

Date Finder

Erase WORDMarker

File Open
File Save

Manage Notes
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WORDMarker Colors
WORDMarker Search Window: Maximize and Minimize




The Right Mouse button will provide you a wealth of information in OMBW. You can

click the Right Mouse button on any button in OMBW and get a description for the
function of that button.

/fD More Information
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| Other Windows & Dialog Boxes

Instructions

With the right mouse button pressed on a button you get instant help for the
function of the button.

= The One-Minute Bible for Windows - [Alm/
=| File Edit Yiew Window Help
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This window provides visual information. You can:

» Click on any of the fields, boxes, list, or other significant parts of any picture
in this window to gain information for the item you chose.

4 Press the Close button to close this window and return to your previous
location.

» Choose Other Windows and Dialog Boxes to close this window and go to the
Windows and Dialog Boxes Table of Contents. You can toggle between Outline or
Alpha for a different view of the contents.
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The One-Minute Bible for Windows has two basic views: the Book View, and the
Almanac View. OMBW opens to the Book View. This view has three main sections:

The MenuBar: The_MenuBar across the top of the window is immediately below
the Title Bar. It has several options. When you select a Menu title, a drop-down
menu appears with menu items. Choosing a Menu item carries out the action.

The ToolBar: The ToolBar is a vertical bar along the left side of the screen. You
can move it from left to right. The ToolBar is a group of buttons in the Book View
that performs tasks when pushed. Press the right mouse button and OMBW will
display an information window telling you the task the button performs, plus the
HotKey, if one is assigned.

The Daily Reading Book: The Daily Reading Book occupies the most space in
the window. It gives you the date, title, and text for your daily Bible reading.

This view allows you to read daily passages from Scripture assignhed by your
computer calendar. You can open the Topical Index and move to any of 450
topics. If there is another text you would like to view, you can press the Related
Texts button and choose from over 700 related Scripture references. You can
locate maps, place BookMarks, write to a NoteTracker, and search for text
highlighted with one of WORDMarkers four vibrant colors.
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The ToolBar is a group of buttons in the Book View that performs tasks when
pushed.

e
i

| =
|n

P EDE

L= EIE

B & = mpe

1B ==

See Also:

The Almanac View
Bible Version
Indexes

Related Texts

Date Finder
WORDMarker Search
Map Locator
NoteTracker
BookMark
WORDMarker
WORDMarker Palette
Erase WORDMarker
File Open

FileSave

Printer

Clipboard




There are two indexes in OMBW. Press either button below to obtain information.

Topical Index

@

Biblical Book Index

o
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Topical Index
The Topical Index option permits you to see the 450 topics provided in OMBW.

To Enter the Topical Index
% Select the Topical Index button from the ToolBar.

Or select View from the MenuBar and choose Index. From Index
choose Topical.

Press ALT + T.

See Also:

To Use the Topical Index
To Choose a Specific Topic and a General Topic

.
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When you enter the index window, it will look like a group of index cards with
alphabetized guides.

To Use the Topical Index
% Double-click on the letter to go to card file index for that letter.

Click once on the letter and a box will appear with that letter,
press the Go To button on the ToolBar.

Press the TAB key to move from letter to letter. When you have
reached the letter you wish to see, press ALT + G to Go To your
selection.
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This is the Topical Index Card File. Choose any letter to go to the alphabetized

Topical card file.
Topical Index

gttributes of God

Entries:

26




Go To: Pressing this button will open the alphabetized Topical Index.



Close: Press this button to return to your previous window.



Alphabetized Card File: You can choose from any letter of the alphabet to see
more topics.



From: This box tells you the first topic under the chosen alphabet letter.



To: This box tells you the last topic under the chosen alphabet letter.



Entries: This box tells you how many topics there are under the chosen alphabet
letter.



From this dialog box, choose the Topic you would like to see within OMBW. Choose
one of the following ways:

To Choose a Specific Topic

% Press the DownArrow button. A drop-down menu will appear.
Choose the specific topic you desire.

Or click once to highlight the topic.

Or press the previous or next button to move forward or
backward between topics.

Or click on a card above the double red lines and it will move to
the front of the stack.

To Choose a Daily Reading Topic

With the specific topic chosen, double-click on the Daily Reading
topic and OMBW will move you to the selected topic.

Or with the specific topic chosen, press the Go To button on the
ToolBar and OMBW will move you to the selected topic.

First, press the "+" or "-" key on the Numeric Keypad to move
from card to card.

Second, press the UpArrow or DownArrow key to move up and
down the list to the topic you want to see. Press ALT + G to go to
the topic, or press ENTER.
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This is the alphabetized Topical Index file which puts you in touch with the 450
topics in OMBW.

Topical Index

adoption
Adam
abstinence
Abraham

Abel
Aaron Feferences: 10

anfronts Pharaoh
God Hardens Pharaoh's Heart
The |sraelites Leave Egypt
The Law: Clean and Linclean
The Law: The Priesthood
The Golden Calf
|srael Rejects the Promised Land
Forty vears inthe Desert
God Crushes Rehellion
Moses Disobeys God




Previous: This button moves you to the previous topic.



Next: This button moves you to the next topic.



Go To: When you press the button OMBW moves to the highlighted topic.



Close: This button closes the current window.



Topics: These are some of the 450 topics which are found in OMBW.



Drop-Down Box: Press the DownArrow button to view all the topics for the
alphabet letter you are currently in.



@ Biblical Book Index
The Biblical Book Index option lets you gain access to the 366 Daily Reading
subjects in OMBW.
To Enter the Biblical Book Index
% Select the Biblical Book Index button from the ToolBar.

Or select View from the MenuBar and choose Index. From Index
choose Book.

Press ALT + I.

*
b



&
&
*

The Biblical Book Index option gives you access to the 366 Daily Reading topics in
OMBW.

Biblical Book Index

Genesis

Jo=hua
Deuterononny

Humbers

Leviticus

Exodus

Genesis Feferences: 28

Creation: In the Beginning
Creation: Let There Be Light
Creation: The Sky Above
Creation: Land and Seas, Plants and Trees
Creation: Sun, Moon and Stars

Creation: All Creatures Great and Small
Creation: The Cattle on a Thousand Hills
Creation: Mankind; The mage of God
Creation: God Rests

Adam and Eve: The First Man and Woman




Next: This button moves you to the next book of the Bible.



Previous: This button moves you to the previous book of the Bible.



Book Drop-Down Menu: This menu lists all the books of the Bible.



Click above the red line to move the card to the front of the stack.



When you enter the Index Window, it will appear as a group of index cards. Choose
a Subject you want to see.

To Choose a Biblical Book and a Subject

% Press the DownArrow button. A drop-down menu will appear.
Choose the Biblical book you desire.
Or click once to highlight the book.

Or press the previous or next button to move forward or
backward between books.

Or click on a card above the double red lines and it will move to
the front of the stack.

To Choose a Daily Reading Topic

With the specific topic chosen, double-click on the Daily Reading
topic and OMBW will move you to the selected topic.

Or with the specific topic chosen, press the Go To button on the
ToolBar and OMBW will move you to the selected topic.

First, press the "+" or "-" key on the Numeric Keypad to move
from card to card.

Second, press the UpArrow or DownArrow key to move up and
down the list to the topic you want to see. Press ALT + G to go to
the Subject or press ENTER.
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Related Texts

The Related Texts choice allows you to see the Scripture references
that relate to the current day's reading. Choosing the Related Texts
button will display a small window with a list of the texts. These texts
are for reference and you may read them from the Bible Study program
that is setup in the ToolBox (see below).

To Enter the Related Texts
Select the Related Texts button from the ToolBar.
Or Select View from the MenuBar and choose Related Texts.

To Read Related Texts
Double-click on the passage you want to read.
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The Related Texts are displayed on a small notepad. If you have a compatible
Windows Bible Study program you can read the Bible text by double-clicking on a

passage.
Related Texts

Genesis 4:1-16
Mumbers 35:9-34
hatthew 15:10-20
John 8:42-44
Romans 1:23-32




Go To Related Texts: Double-click on a specific passage to start the Bible study
program that is setup in the ToolBox to read the context.



Date Finder

You can read any of the Daily Reading selections by choosing the Date Finder
option. When you make your date selection, OMBW will move you to the reading
selection for that date.

To Enter the Date Finder
% Select the Date Finder button from the ToolBar.
Or select View from the MenuBar and choose Date Finder.

Press ALT + D.
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If you want to move to another day in the calendar year, just enter the month and
day and press OK.

Date Finder




Month: Enter the month you wish to move to.



Day: Enter the day you wish to move to.



Cancel: Press Cancel to return to the previous page.



OK: Press this button to move to the date you have requested
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WORDMarker Search

The WORDMarker Search option lets you search for colors you have used in any
work session.

To Use WORDMarker Search

% Select the WORDMarker color you want to search for from the
ToolBar and press the WORDMarker Search button.

Or select Edit from the MenuBar and choose Search.

Press ALT + O and choose a color by pressing the designated
letter.

Press ALT + S.




&
&
L

OMBW will search for the color you have selected and a search box like the one that
follows. You can scroll your selections. When you discover the one you want to view
in the Book Reading window, press the Check or double-click on the option. To close
the window, press the Red X button or press ESC. The question mark button is Help.

To search for a different color, press any WORDMarker button at the bottom of the
window. The WORDMarker window will stay active and the new selections will
appear.

WORDOMarker Search

Adarn and Eve: The First Man and YWoman
Moah: The Righteous Man

Ezau Zellz Hig Inheritahce to Jacob

Job Protests His Ihnocence

[—— | ——| —| | []][Z]
WORDMarker Search Window Maximized

If you want the WORDMarker Search window to remain active as pictured below,
you may press the minimize button in the upper-right corner of the window and the
palette will scroll down to the Window title bar as pictured below. To maximize, press

the maximize button in the upper-right corner of the Window title bar.
[=] WORDMarker Search ]
T 1

WORDMarker Search Window Minimized




WORDMarker Color: Indicates the present color that was chosen when you
minimized the WORDMarker Search dialog box.



g Map Locator

By using the Map Locator, you can choose from seven maps within OMBW. When
you choose a map, a thumbnail view will be shown in the Preview window at the top
of the Map Locator window.

To Enter the Map Locator and Choose a Map
% 1 Select the Map Locator button from the ToolBar

Or select View from the MenuBar and choose Map Locator.
Point to the map you want to view and press the button.
Press OK.

w N

Press ALT + M.

Press the number of the map you wish to view.

Press ALT + O to go to the map.

Press ALT + | to read information about the map.

Press ALT + C to close the information window.

Press ALT + C again to close and go back to the main view.

OO Uk, WN
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Press the Map Locator button a map selection window appears like the one pictured
on the left. When you select a map the window changes to one like the right with a
thumbnail picture of the selected map.

Map Locator Map Locator

Pregiews

Select A Map

A thumbnail view will be

dizplayed frere. Press
"QE" to view RMf-size

1 Old Testament |srael 1 Old Testament Israel

2 The Assyrian Empire 2 The Assyrian Empire

3 The Bahylanian Emnire 3 The Bahylonian Empire




Map Selection: Press this button to see a thumbnail view of Old Testament Israel.



OK: Press this button to go to a selected map.



Print: Press this button to print the currently selected map.



Close: Press this button to return to your previous window.



Help: Press this button to receive context-sensitive help.
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You can choose to print or read information.

5 - [Map: Old Testament Israel] ¥

@

wiament Israel

* Damascus

Kadesh Barnea



Info: Press this button to read information about the selected map.
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When you press the Info button from the Map window, you will see a window like the
one on the left with information about the selected map. To see the approximate
geographic location of the map on a globe, press the globe button to toggle to
another window like the one pictured on the right.
Map Information

Map Information
Location | Print Close

lztael in the Old Testament Period had
zevergl different configurations.

Before the Conguest: From Sidon

oh the north seacoast of the Mediterranean
lo Gaza on the south seacoast of the
Mediterranean, the land was inhakited by
the Sidonians in the notth, the Cansanites
from the cosst to the Jordan River, and
the &malekites inthe south. The inland
countries were the Hittite Empire in which
Damascus was located, Bashan, the
Kingdom of Zihon where the Amorites
lived: Aprmon, Moak, and Edorn. 3 Relative location of selected map.




Location: Press this button to see the general geographic location of the map.



Text: Press this button to return to the Info text.



General Location: This marks the general geographic location of the map.



E NoteTracker

The new NoteTracker feature in OMBW has the traditional features of a notepad plus
a way to manage your notes and link them to a calendar day. You can see when you
have a note linked to a day by the NoteTracker icon which will appear on the left
page next to the curl that flips the page to a previous day. Pressing on this button
will allow you instant access to your note manager. You can select any of up to ten
notes that you may have linked to this day.

With OMBW's NoteTracker option you can keep an accurate record of what you are
learning as you read the Daily Reading selections and study the information
provided in the Almanac View.

In the ToolBox you may select Windows' Notepad, your favorite word processor, or
NoteTracker. NoteTracker is the default option.

To Enter NoteTracker
% Select the NotePad button from the ToolBar.
Or select Edit from the MenuBar and choose Notes.

Press ALT + N.

NoteTracker, Notepad, or your word processor will open for you to
use.

See Also:

NoteTracker

ToolBox

*
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The new NoteTracker feature in OMBW has the traditional features of a notepad plus
a way to manage your notes and link them to a calendar day. You can see when you
have a note linked to a day by the NoteTracker icon which will appear on the left
page next to the curl that flips the page to a previous day. Pressing on this button
will allow you instant access to your note manager. You can select any of up to ten
notes that you may have linked to this day.

(3
4
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Each button function is explained below.

Manage Notes: The Manage Notes function allows you to
manage all of your OMBW notes from one place. You can
even name them with more than the conventional eight
letters that is required in the external notepad or word
processor. When you click on this button, you get a list of
the full names of the notes that you have saved in the
current WorkSet. Press the Manage Notes button to the left
to see the Manage Notes dialog box.

File Note: After you have keyed in your information, you
can file your note by clicking on the File Note button and
entering the name of the note. The name can use up to 255
characters.

Discard Changes: Pressing this button will delete any
changes you have made to the note since it was last saved.

Font Change: You can change your font, font style, size,
effects, and color by pressing this button. The default font
is Arial Normal 10. This change will be reflected throughout
the whole note.

Search, Search Again, Search and Replace: You can
search through your note for any word, phrase, etc. When
you have searched and found the first occurrence and you
wish to find another occurrence, press the Search Again
button. To search through a note for a word or phrase and
replace with another, press the Search and Replace button.

Date and Time Stamp: Press this button to have OMBW
place the current date and time from your computer's clock
in the note at the cursor position.

Paste, Cut, Copy: These are standard Windows' features.
you may also access these features through your keyboard
with the following commands: CTRL + X = Cut; CTRL + C =
Copy; CTRL + V = Paste.

Undo: Pressing this button will undo the last changes you
have made to your note. This is different from Discard
Changes which deletes all changes since the last save.
Link: If you want to link your note to a current day, you

may do so by pressing this button. Up to ten notes may be
linked to a given day.
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Unlink: If you have chosen to link a note to a specific and
wish to unlink it for any reason, press this button and the
link with the present day will be deleted.

Go To Link: When the button is grayed out, there is no link
for this note. When this button is activated, it will have a
Red arrow visible. With your note selected, you can press
this button to view the day to which the note is linked.

Print: Press print to print the current note.
Exit: Pressing the Exit button to close the NoteTracker.
Help: Press the Help button to get help for NoteTracker.
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You can save many notes in each WorkSet and link up to ten for any given day. This
is the control panel for managing your WorkSet notes.

Showing Kindness by Fargiving

Mew Title:
What does it mean to be Kind?
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When you link a note or copy to the Clipboard an icon appears on the left page of
the Daily Reading selection. Press you Left Mouse button over the Link icon to see

what notes are linked to the Daily Reading and the Right Mouse button over the
Clipboard to see the name of the Daily Reading topic you copied to the Clipboard.

S

Ints.
Surel God is good to Isra
to those who are pure in

Forthe Lord is good and his I\I-:N‘nsw_,h
endures forever; T
his faithfulness continues through all
pgenerations.
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Note Link: This icon appears on any page that has a note linked to that day.



Clipboard Icon: When you drag the Daily Reading to the Clipboard, this icon
appears.



Edit: Press this button to open the selected note to edit.



Delete: Press this button to delete the selected note.



Print: Press this button to print the selected note.



Retitle: Press this button to retitle the selected note. Enter the new title in the New
Title box and press Retitle.



Up: Press this button to move a note up one position in the Notes list.



Down: Press this button to move a note down one position in the Notes list.



New Title: Enter the title first and then press New Title.



Note List: This is a list of all the notes you have created in this WorkSet.



Close: Press this button to close the Manage Notes dialog box.



BookMark

Using the BookMark option allows you to move within OMBW to a specific location
that you have previously selected. You may choose up to ten BookMarks for future
reference. Your BookMarks will be saved as a part of your WorkSet when you Exit
OMBW.

&

To Enter, Use, Go To, and Delete a BookMark
% First, select the BookMark button from the ToolBar.
Or select Edit from the MenuBar and choose BookMark.

Second, press the New button from the ButtonBar at the top of
the window.

Or double-click in the first available box beside a number.

Third, choose the BookMark you wish to add by clicking your
pointer on the number on the left side of the dialog box, or in the
right-hand box beside your selection. A check mark will appear.
Press the Go To button.

Or double-click on a BookMark.

Fourth, select a bookmaker to delete and press the Delete
button to delete a BookMark.

OMBW will place the daily reading topic at the next available position from one to
ten. If there is already a BookMark in the position you have chosen, OMBW will
prompt you with the question: This BookMark slot is already in use. Replace with
new BookMark? If you say OK, a new BookMark will replace the old. If you respond
No, you will return to the BookMark dialog box. You may have duplicates if you
choose.

First, press ALT + K.

Second, press a number on your keyboard and the topic in the
current active Book View window will become a BookMark.
Third, press the UpArrow or DownArrow key to move the check
mark.

Press ALT + N to add a new BookMark where the check mark
appears.

Fourth, press ALT + D to delete a BookMark where the check
mark appears.

*
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The BookMark feature allows you to set up to ten BookMarks. You can add or delete
at any time. They are saved with your WorkSet.
Bookmarks

EDED C

1 | The Fruit of the Spirit: Seff-Cantral |«

ﬂ God |s Slow to Anger |J
ﬂ The Plagues Against Egypt |J
|_|
|_|
|_|
|_|
|_|
|_|
||
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New: Press this button to enter a new BookMark at the selected line.



Delete: Press this button to delete the selected BookMark.



Go To: Press this button to Go To the Daily Reading of the selected BookMark.



BookMark Name: The names of the BookMarks are the Daily Reading topics.
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WORDMarker

The invention of the color highlighters has added variety to marking paper
documents for future reference. Logos Research Systems has developed a new
electronic technology which we call WORDMarker. WORDMarker allows you to use
electronic markers to highlight text in the Book Reading window. OMBW gives you
the use of four different color WORDMarker buttons. These give you the opportunity
to choose different colors to represent different concepts, topics, events, or persons
you want to highlight. For example, you may mark every place in blue that refers to
God and creation. When you choose a second color, the daily reading page will clear
itself of your first color marks. You can now add another color which will be
displayed for you. You can revisit any color you have used by choosing that color
marker again. When you Exit OMBW, you may save your highlighted markings for
future reference.

To Use a WORDMarker
% Select a WORDMarker button from the ToolBar.

Or select WORDMarker from the MenuBar and choose your color
preference--Red, Blue, Green, or Yellow.

*
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You can choose to color the Daily Reading text with any of the four colors and save
the highlights with your WorkSet.

The One-Minute Bible for Windows - [The Book [KJV]:
Edit VYiew WORDMarker Window Help
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#_| WORDMarker Palette

When you choose the WORDMarker Palette, a small palette like the one below will
become visible. You can change the names you have assigned by clicking on the
name and keying in another, or through the ToolBox. You may also see what you
have marked by pressing the color box. For example, when you press the blue box,
all the texts on the Daily Reading selection that you have marked in blue will
appear. A check mark will appear in each color box where highlighting for that color
has occurred. When a check mark appears in a color box, it means that you have
used that color WORDMarker on the page.

To Use and Minimize the WORDMarker Palette

% Select the WORDMarker Palette button from the ToolBar.
If you want the WORDMarker Palette to remain active as pictured
below, you may press the minimize button in the upper-right
corner of the window and the palette will scroll down to the
Window title bar as pictured below. To maximize, press the
maximize button in the upper-right corner of the Window title bar.
To Toggle the WORDMarker Palette On and Off

Using the following keyboard strokes toggles the WORDMarker
Palette on and off:

1 Press ALT + O.

2 Press P and the WORDMarker Palette will appear.
then

1 Press ALT + O.

2 Press P and the WORDMarker Palette will disappear.

Note You may only use one color on the screen at a time. When you choose
another WORDMarker, the first color disappears. To show which colors are in use,
refer to the WORDMarker Palette. If a WORDMarker button is pressed and you open
a dialog box or another window, the text will be refreshed. This is done to preserve
your color highlights.

L7
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You can label the four colors with names in each of your WorkSets as demonstrated
below.

W ORDMarker Palette

Prophets

Angel

Fire

(1) 0

General




Blue: Press the color Blue and your Blue WORDMarker highlights will show on the
Book View page.



Green: Press the color Green and your Green WORDMarker highlights will show on
the Book View page.



Red: Press the color Red and your Red WORDMarker highlights will show on the
Book View page.



Yellow: Press the color Yellow and your Yellow WORDMarker highlights will show on
the Book View page.



Double-click on the word to change it.



Press the UpArrow button to Maximize the WORDMarker Palette.



Press the DownArrow button to Minimize.



@ File Open

When you Exit OMBW, the WORDMarker highlights and BookMarks you have added
while using OMBW will be saved in a file. At any time during your session you may
open a previously saved file.

To Use File Open
% Select the File Open button from the ToolBar.
Or select File from the MenuBar and choose Open.

Press CTRL + O.

Choose the file you wish to open and press OK or double-click on the file name.

OMBW will keep track of the last five files you have used. You can choose to open
them from the File option on the MenuBar.
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:‘ﬁ Erase WORDMarker

If you change your mind about the text you have highlighted using the electronic
WORDMarker, you may choose what you wish to erase and use the Erase
WORDMarker button to perform that procedure.
To Use Erase WORDMarker
% Press the Erase WORDMarker button and the Color WORDMarker
button for the color you want to clear. When you move your mouse
pointer to the Daily Reading selection, your mouse pointer changes

to an eraser. Place the eraser over the color and press the left
mouse button to erase the color.

*
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You can choose to erase any of the colors at any time. Just press on the color
WORDMarker then press the Erase WORDMarker button. The mouse pointer will

change to an eraser. Place on the line you wish to erase and click the left mouse
button once.

.
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________ Printer

Clipboard

There are two Drag and Drop Buttons on the Book View ToolBar. The primary use of
Drag and Drop is to select the text you wish to print or to place text on the Windows
Clipboard. Press your left mouse button on the Book View selection. Notice that it

changed to a hand and page icon. Drag to the Print or Clipboard button and Drop
(release the mouse button). The action occurs immediately.

Press buttons to go to topics.




Printer

If you have installed and connected a printer, you can print the following:

In the Book View of OMBW you can print the Daily Reading selection by
placing your mouse pointer on the text, pressing the left mouse button, dragging it
to the Print button, and dropping it (releasing the left mouse button).

In the Almanac View you may print any of the Book Profiles by doing
one of the following:

From the map window you can print the selected map.

—_______  From the Info window for the maps you can print the information about
the map.
For information about installing your printer in Windows, see the Microsoft Windows
User's Guide, Chapter 6, Print Manager.

To Use the Print Function in the Book View

% Select the text by placing your mouse pointer anywhere on the
Daily Reading selection. Press the left mouse button. Notice the

pointer icon changes to a can't drop icon (a circle with a line).

Hold the button and drag it across to the Printer button. The

pointer will turn into a hand and page icon. When you see this

icon drop it (release the button). The print action occurs

immediately.

Or press the Printer button from the ToolBar. A printer dialog box

will appear. Make your selection and press OK.

Select File from the MenuBar and choose Print.

Or press CTRL + P

To Use the Print Function in the Almanac View

% Press the Print button and a printer dialog box appears. From there

you can choose to print the Book Profile or the Book Outline for the
book which is highlighted in yellow in the Almanac window.

Or press your left mouse button on the selected book and drag it to
the printer and drop it. Notice that the pointer turns into a can't
drop icon (a circle with a line). When the pointer is over the print
button, the icon turns into a hand holding a book. When you see
this icon drop it (release the button).

Or press CTRL + P for the printer dialog box.

Clipboard




When you press the print button this dialog box appears. Make your choices and
click OK.

|HP DeskJet 550C Printer on LPT1:
Prnnt Range
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» Pages
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Current Printer: The current printer is identified.



Print Setup: Press this button to open the Windows printer setup dialog box.



Clipboard

The Windows Clipboard provides temporary storage for information you want to
transfer from one application to another. You can copy information from OMBW Book
View onto the Clipboard and then transfer that information from the Clipboard into
your favorite word processor or any other Windows application.

To Use the Clipboard in the Book View

% Select the text by placing your mouse pointer anywhere on the
Daily Reading selection. Press the left mouse button. Notice the
pointer icon changes to a can't drop icon (a circle with a line).
Hold the button and drag it across to the Printer button. The
pointer will turn into a hand and page icon. When you see this
icon drop it (release the button). The print action occurs
immediately.

Or Press the Clipboard button from the ToolBar. The Clipboard
icon will appear on the lower right side of the left Daily Reading
page, indicating that you have sent the text to the Clipboard.
Press the right mouse button over the clipboard icon on the
Daily Reading page and OMBW will inform you the name of the
last item that you placed on the clipboard.

Press the button below to get information on the Printer.

Printer

.
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|Ei|e Edit ¥Yiew WOHDMarker WWindow Help

The MenuBar in OMBW lists for you the available menus from which you may choose
procedures. When you click your mouse pointer on a word on the MenuBar, a drop-
down menu appears. A menu contains a list of commands you may ask OMBW to
perform. Most Windows applications have a File menu, an Edit menu, and a Help
menu. Other menus available are unique to the application you are using. In OMBW
the MenuBar in the Book View contains File, Edit, View, WORDMarker, Window, and
Help menus.
See Also:

File

Windows

"
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Open
Save
Save As

Print
Printer Setup

Exit Alt+F4
There are three options that you can use from File on the MenuBar: New, Save, and
Save As.

New: Choosing this procedure will open a new file in which WORDMarker and
BookMark information are placed as you use OMBW. Each time you enter OMBW you
are in a New file.

To Use the New Command
Select File from the MenuBar and choose New.
A dialog box will appear. Enter the name of the file.

@ File Open

Open: All of your previous files are stored away for you and can be easily accessed
by choosing the Open option from the File Menu. We call these files WorkSets

To Open A Previously Saved File
Select File from the MenuBar and choose Open.
A dialog box will appear. Choose the name of the file to open.

% File Save

Save: Choosing this procedure will save your file for future use. You use Save to
save changes to an existing file.

To Use the Save Command

Select File from the MenuBar and choose Save. The file will be saved if
you have given it a name. If there is no file name, a dialog box will
appear. Enter the name of the file.

Save As: Choosing this procedure will save your existing file under a new file name.
This command is used when you want to keep a copy of the original file as it existed
before you began your work session.

To Use the Save As Command

Select File from the MenuBar and choose Save As.

Enter the new file name.

*
"



Press the File Save button and enter the name of the file to save. Make your choice
and press OK.

= Save File As

File Hame: Directories:

|m c:\ombw

[= e\
E= ombw

List Files of Type: Dnves:
DMB Files E [=«




Press the File Open button to choose the WorkSet file that you want to open. Make
your choice and press OK.

= Open File

File Hame: Directories:

|m c:\ombw

joy.omb [= e\
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List Files of Type: Dnves:
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File Name: Give your file a name. The .OMB extender is given to your file name
automatically.



File Name: The name which appears in this box will be the file that will open when
you press OK.



File List: These are the current files that you have saved away when using OMBW.
This list helps you name your new file with another name than the current ones
listed. Giving the file the same name as the one listed will overwrite the present file
with the new one. Of course this is OK when you are adding more information to a
present file. You can also choose which file to open from this list.



File Type: Gives the type of files that you are saving or opening.



Directories: This box tells you the current drive and subdirectory that you are in.



Window
Arrange lcons

Close All

+1 The Book [New International Yersion]: UNTITLED.OMB
2 Almanac: The Old Testatment
3 Book OQutline: Genesis

The Windows menu keeps track of all the windows you open while working in OMBW.
You may open as many windows as your system memory will allow.

Arrange Icons: Each time you minimize a window, it becomes a small icon at the
bottom of the main window. The minimize button is the DownArrow button at the
top right of a window. The UpArrow button is a maximize button.

To Use Arrange Icons

Minimize all windows.

Select Windows from the MenuBar.
Choose Arrange Icons.

Or press ALT + W + A.

Close All: This option allows you to close all the windows that have been opened as
you have used OMBW.

To Use Close All

Select Windows from the MenuBar and choose Close All. This option
will close all active windows in OMBW.

Or press ALT + W + C
Active Windows Opened

Below the Separator bar all the opened windows will be listed. A check mark
appears beside the one that is active (appears in front).

To Select Another Window

Select Windows from the MenuBar and choose any window that is
opened. OMBW will move to that window and display it for you.

Or press ALT + W + the number of the window: 1, 2, 3, etc.

.
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The Daily Reading selection is the third part of the Book View window. This is the

beginning window that will appear each time you start OMBW. Note that the window

looks like a book. The date and daily subject are on the left page at the top followed

by the Daily Reading from the New International Version or King James Version of

the Bible. The Bible references for the Daily Reading are displayed at the conclusion

of the text and appear with underlines. Press on the underlined text to go to the

Bible Study program selected in the ToolBox to display the selected text.

When you enter OMBW, the Daily Reading page appear. It is easy to move around
the page. There are only three procedures that will occur on this page without
pressing a button from the JoolBar or without choosing a MenuBar option.

1 You may move your mouse pointer to the bottom of either the left or right
page. When your pointer is over the fold, it will turn into a finger pointing
either left or right. As you click the mouse button, the pages will flip one day
at a time in either direction. From the keyboard use the RIGHTARROW or
PAGEDOWN key to move to the next day. Use the LEFTARROW or PAGEUP key
to move to the previous day. Use the HOME key to return to the current day.

2 Down the middle of the current date page you will see a red bookmarker. As
you flip forward or backward by flipping pages or by using the Date Finder
option, the bookmark will stay with the current day. You will see it protruding
from the bottom of the page when you have move to a different day. When
you place your mouse pointer on the bottom of the bookmark, your pointer
turns to a DownArrow pointing to an open book. When you click the left
mouse button, you will return to the current day's selection.

3 You can press your left mouse button anywhere on the page and the mouse
pointer will turn into a hand and page icon. You can then drag the icon to the
Print or Clipboard button and drop it (release the button). The Daily Reading
selection prints if you drop the icon on the Print button. The Daily Reading
selection is copied to the Windows Clipboard if you drop the icon on the
Clipboard button. A small Clipboard icon appears on the page to indicate that
you have copied the Daily Reading to the clipboard. From the Windows
Clipboard you can Paste into any other Windows application.

See Also:

ToolBox
Quitting The One-Minute Bible for Windows

Online Help
Pritner

Clipboard
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Bookmarks Al+K
Notes Alt+N

The OMBW ToolBox allows you to set your preferences. The ToolBox is designed to
allow you to enter preferences about certain key operations within OMBW. The
choices you make in the ToolBox dialog box become the defaults for those functions.
You may change them at any time by reentering the ToolBox and making different
choices.

When you choose the ToolBox button, you will see a dialog box. Make your selection.

To Enter Your Preferences in ToolBox
Press ALT + E + T.

.
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Edit Menu - ToolBox: You can open the ToolBox by selecting Edit from the MenuBar and
choosing ToolBox.



You can set your = ToolBox

prefe rences in ToolBox ~Book ToolB ar Almanac ToolBar
a.nd change them at any & Onie & OnTap
time. » On Right » On Bottam 1
~OMB “erzion
“  KingJames A

2 Mew Intermational

~Matepad THE QNI
 External & MNoteTracker %I?%UE%
Program |
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WORDMarker / Ok

e | naszioned P

e |Unassigned annceI
B (Unassigned

Unazzigned ?Help

Bible Study DDE: Press this button when you are setting up a compatible
Windows Bible Study program to DDE Link with in order to read the complete text of
the Bible. Compatible Windows Bible Study programs are Logos versions 1.6 and
above, from Logos Research Systems, Inc.. QuickVerse for Windows versions 1.0f
and above from Parsons Technology. WordSearch for Windows 3.0 and above from
NavPress Software. VerseSearch for Windows versions 1.0 and above from Bible
Research Systems.



Book ToolBar: On Left or On Right: When you return to the Book View, your
ToolBar will be on the left or right side of the window as you have indicated.



Almanac ToolBar: On Top or On Bottom: When you move to the Almanac View,
your ToolBar will be at the top or bottom of your window as you have indicated.



Timeline: Click in Box (Check Mark On or Off): When you move to the Almanac
View, the TimeLine ToolBar will be activated. It will be visible below the Almanac
View ToolBar.



External NotePad: If you click External Notepad, the internal default notepad is
Windows' Notepad. If you wish to use another word processor or text editor, click
the Browse button and look in the word processor's subdirectory and choose the
EXE file. This will allow you to use any word processor or text editor as your OMBW
notepad. If you know the path and EXE or the word processor or text editor you can
key it in the box above the Browse button.



NoteTracker: NoteTracker which comes with OMBW is the default setting. Leave
the selection as it is and you will use the new OMBW NoteTracker as you notepad.



Browse Button: Press this button when you are setting up an External NotePad to
choose the EXE file for the Word Processor of your choice.



WORDMarker Descriptions: Click in the first box and the word Unassigned will
highlight. Type any descriptive word that you want to use for this color in this
WorkSet. For example, you might type Prophet in the box next to the Blue
WORDMarker to indicate that you are marking anything you wish to remember
about Prophets with your Blue WORDMarker



OK: Press OK. You will return to the Book View and your changes will be recorded.



Cancel: Press this button to Cancel and return to the program without any changes
being recorded.



Help: Press this button to receive context-sensitive help on the ToolBox.



You may quit OMBW in the following ways:
% Choose File from the MenuBar and then choose Exit.

Or Double-click on the Control-menu box that is the top left box
on the window.

Or Click once on the Control-menu box and select Close
from the menu.

Press ALT + F4.

KJ

New International Version

Pressing this button toggles the Daily Reading between the King James and New
International Versions of the Bible in the Book View.

*
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King James Version




Bible Version: Press this button to toggle between King James and the New
International Version of the Bible Daily Reading text in the Book View window.



Blue WORDMarker Highlighting: This is how the text looks when highlighted.



WORDMarker Erase: You can erase any color highlighting with the eraser.



File Open: (CTRL + O): Press the File Open button to see a list of the files in which
your WORDMarker, BookMark data, and NoteTracker notes are saved.



Printer (CTRL + P): Press the Printer button to print or drag and drop on the
button.



File Save: Press this button to save the current WorkSet.



Clipboard: Press the Clipboard button to store a temporary text you wish to use in
another Windows application.



OK: Press this button to save changes in dialog box or carry out the command of
the dialog box.



Cancel: Press this button to cancel the dialog box and return to the previous
window.



;@ The Old Testament |* rﬁfdﬁ]l ﬂ @ H @/
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The Almanac View Button gives you access to the functions and information in the
Almanac View. You can find information, print, get help at the click of your mouse.

See Also:
The Book View
Category Selection
Testament Overview
Chronological Overview
Book Overview
Book Selection
Book Outlines
Book Profiles
Using The Book Outlines And Profiles
View Order
Map Locator
Timeline
TimelLine SlideBar
Printer
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This is the end of this topic.



The Almanac View is full of dazzling graphics. Enjoy the experience of learning.
The One-Minute Bible for Windows - [Almanac:;
File Edit Yiew Window Help

The Old Testament




Book View: Press this button to return to the Book View.



Category Selection: Press the Right Arrow and a drop-down box appears with
three selections: the Old Testament, the New Testament, and the Apocrypha. Click
on your choice. Old Testament is the default.



View Order: Press this button to see the choices of different biblical order views.
You have three choices in each of the Categories: Bible Order, Chronological Order,

and Topical Order. Click on your choice and the window will repaint to reflect your
choice.



Bible View: Press this button to go to the first chapter and first verse of the
selected book. In order to use this button you must have a compatible Windows
Bible Study program selected the ToolBox.



Outline: Select a book by clicking on it and then press this button to see an Outline
of that book.



Profile: Select a book by clicking on it and then press this button to see a Profile of
that book.



Maps: Press this button to go to the map section.



Timeline: Press this button to toggle the TimeLine Bar off and on.



Printer: Press this button to get a print dialog box from which you can select to
print either the Book Profile or Outline of the book which is highlighted. Or you may
select the book and drag to the Printer button and drop to print the Book Profile.



Help: Press this button to go to Help's Contents window.



Testament Overview: Pressing this button will give you an overview of the chosen
category.



Chronological Overview: Pressing this button will give you a chronological view of
the category you have selected.



Book Overview: Pressing this button produces a drop-down box from which you
can choose a Book Profile or a Book Outline.



Book Graphics: This is a representation of the graphics of the books of the Bible.



The 0ld Testament |*

You may choose from one of three categories: the Old Testament, the New
Testament, or the Apocrypha. When you select the category, the graphical
representation of the books of the Bible are shown on your screen.

To Use Category Selection

Press the DownArrow button on the ToolBar next to the Category. A
drop-down menu will appear offering you the selection of Old
Testament, New Testament, or Apocrypha.

Or select View from the MenuBar. Select Reference. A new dialog box
will appear with three option buttons from which you can choose: Old
Testament, New Testament, or Apocrypha. When you make your
choice, you may also choose a specific book from the category as well.
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= | Testament Overview

There are three overviews that you can read in OMBW: the Old Testament, the New
Testament, and the Apocrypha. These overviews provide basic information about
each of the Bible Testaments and the Apocrypha.

To Read An Overview

Press the Testament Overview button and the overview for the
category that is displayed in the Category Selection box will be
displayed.

*,
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You can read an overview of the Old Testament, New Testament, or Apocrypha by
pressing the Testament Overview button.

= The One-Minute Bible for Windows - [Topical Overview: The New Testami
= File Edit Yiew Yindow Help
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€ Bible Order
E Chronological Order
ﬁ Topical Order

There are three ways you can display the biblical order in OMBW. Each of these
views expresses a different vantage point from which to view the order of the
Biblical books and the Apocrypha.

Choose any of the orders in the above graphic for information about the specific
order.
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There are three topics which cover the Chronology of each of the Bible Testaments
and the Apocrypha. These articles provide a date-by-date sequential history.

To Read the Chronological Overview
Select the Bible Testament or Apocrypha in the Category Selection box.
Press the Chronological Overview button on the ToolBar.




[il Book Outline
("] Book Profile
The Book Overview button gives you access to either the Book Profile which is
introductory with an expanded outline or the Book Outline.

Press on the Drop-down menu above to go to either Book Profile or Book Outline.
To Read Book Profile or Book Outline

Press the Book Over button.

Choose Book Profile or Book Outline. You will open the book you have

highlighted in the Almanac View graphic of the Bible books or
Apocrypha.




€ Bible Order

E Chronological Order
ﬁ Topical Order

Bible Order

Your paper Bible begins with Genesis and ends with Revelation. Choosing Bible
Order will let you view the books of the Bible in this same order. Each category of
book has a different color. The Apocrypha is displayed as a separate selection. In
the Catholic Bible the Apocryphal books are part of the Old Testament and are
ordered differently.

To View Bible Order

% Select the Order View button from the ToolBar in the Almanac
View. and choose Bible Order.

Or select View from the MenuBar and choose Order. A sub-menu
will appear to the right. Choose Bible.

Press CTRL + B

See Also:

Chronological Order
Topical Order
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€ Bible Order

: Chronological Order

ﬁ Topical Order

Chronological Order

The Chronological Order of the biblical books displays the books in the order of their
story line for the Old Testament books. They are viewed by date of writing for the
New Testament and Apocryphal books.

To View Chronological Order

% Select the Chronological Order button from the ToolBar in the
Almanac View.

Or select View from the MenuBar and choose Display Order. A
sub-menu will appear to the right. Choose Chronological.

Press CTRL + C.

See Also:
Bible Order
Topical Order
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€ Bible Order
E Chronological Order

ﬂ:m Topical Order

Topical Order

The Topical Order of the biblical books provides you with the specific major kinds of
literature within the Old Testament, New Testament, and Apocrypha.

To View Topical Order

% Select the View Order button from the ToolBar in the Almanac
View and choose Topical Order.

Or select View from the MenuBar and choose Display Order. A
sub-menu will appear to the right. Choose Topical.

Press CTRL + T.

o
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The Law History BN Topical Overview

Press the Overview button at the bottom of the window for the Topic you wish to
read.

To Read About the Topics Using the MenuBar

% Select View from the MenuBar and choose Overview. Your current
active view of the books--Old Testament, New Testament, or
Apocrypha--will appear on a sub-menu to the right. For example,
if Old Testament is your current active view, the Menu will have
the selection of Old Testament, Chronology, Law, History, Poetry,
Prophets.

Press ALT + V + V plus the underlined letter you want to view. For
example: ALT + V + V + L would choose The Law for you to view.

To Read About the Topics Using Buttons

% Press the color-coded Overview button at the bottom of the
window for the Topic you wish to read.

See Also:

Bible Order
Chronological Order
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Topical Overview

Press the Overview button at the bottom of the window for the Topic you wish to
read.

To Read About the Topics Using the MenuBar

% Select View from the MenuBar and choose Overview. Your current
active view of the books--Old Testament, New Testament, or
Apocrypha--will appear on a sub-menu to the right. For example,
if Old Testament is your current active view, the Menu will have
the selection of Old Testament, Chronology, Law, History, Poetry,
Prophets.

Press ALT + V + V plus the underlined letter you want to view. For
example: ALT + V + V + L would choose The Law for you to view.
To Read About the Topics Using Buttons

Press the color-coded Overview button at the bottom of the
window for the Topic you wish to read.
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Timeline

Choosing the TimeLine button will display the TimeLine ToolBar from which you may
choose and view twenty-nine summaries of Biblical and World History.

p I 7 . 266 B.C. 4 Jsticn a0 14| P ¥

The TimeLine feature of The One-Minute Bible for Windows is an excellent way
for you to visit Biblical times. We have divided the time into twenty-nine periods
with a World History and a Biblical History section for each.

p Period Overview: You may press this button to see
the Period Overview which is selected in the Time
Period box to the right.

7 - 2166 B.C. Time Period: You may press the DownArrow button
and a drop-down box appears from which you can
choose any of the twenty-nine time periods.

E| Next Time Period: You may move forward through
the twenty-nine time periods by pressing the Next
Time Period buttons.

E| Previous Time Period: You may move back through
the twenty-nine time periods by pressing the Previous
Time Period.

Timeline Link: The TimeLine Link button will link
the TimeLine to the graphical book display so that, as
you click on a book, the time period date box and
SlideBar will move automatically to the time period of
the selected book.

¥y TimelLine Unlink: Choosing Unlink keeps your
choices and the TimeLine separate.
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Pressing the Globe button will allow you to see a brief outline of World History.

The One-Minute Bible for Windows - [Time Py
Edit ¥Yiew Mindow Help

» The Northern King



You can switch between World History and Biblical History for any time period.




Globe: Pressing the Globe button provides you with a brief outline of World History
for the time period.



Time Period: This drop-down box makes available all time periods in OMBW.



Bible: Pressing the Bible button provides you with a brief outline of the Biblical
History time period.
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The TimeLine SlideBar moves you from time period to time period within the twenty-
nine periods in OMBW. As you move the SlideBar, the time you are selecting
appears in the time indicator box to the left.

To Use the Timeline SlideBar

Point to the SlideBar and press your left mouse button. Then, drag the
SlideBar along the line left or right.

*
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m Map Locator

By using the Map Locator procedure, you may choose from seven maps within
OMBW.

To Enter the Map Locator
% Select the Map Locator button from the ToolBar.
Or select View from the MenuBar and choose Map Locator.

Press ALT + M.




You can choose any Old Testament, New Testament, or Apocryphal book in the
Almanac View. When selected, the book will be highlighted and you can use the
Book Outline button or the Book Profile button to read information about it.

To Choose a Book

% Place your mouse pointer on the book in the Almanac View and
click the left mouse button.

Or select View from the MenuBar and choose References.

Press ALT + R.

When you choose either of the last two functions, a new reference dialog box will
appear. You can move around within the dialog box by using your TAB key. Tab to
the first box and type the book you want to select and press ENTER.

See Also:
Book Pop-Up Menu




You can choose Old Testament, New Testament, or Apocrypha and then choose any
book to highlight in the AlImanac View.

MNew Reference

= Hew Testament
 The Apocrypha

|_Eenesis

Exodus
Leviticus
Mumbers
Deuteronomy
Joszhua
Judges
Ruth

1 Samuel

2 Samuel

1 Kings

2 Kings

1 Chronicles
2 Chromicles
Ezra
Mehemiah

E sther




Reference Choice: Click on the Old Testament, New Testament, or Apocrypha. The
list below will change accordingly.



Selected Book: The book that appears in this box is the one that will be selected
on the graphical book display when you press OK.



List Of Books: You can choose form this list by clicking on the book.



Scroll Bar: Scroll up or down to find the book you want.



[il Book Outline
("] Book Profile

Book Outline

OMBW has provided an Outline of each book of the Old Testament, New Testament,
and Apocrypha. They are outlined in a form that will help you as a student of the
Bible to remember the contents of the book.

To Enter a Book Outline

% Choose the book by pointing and clicking on the book.

Select the Book Overview button from the MenuBar. and a drop-
down menu will occur. Choose Book Outline and OMBW will open
an outline window of the book you have chosen. You may move
from the Outline to the Profile by pressing the Profile button.

Or select View from the MenuBar and choose Outline.

Press ALT + O.




There are informative outlines of each of the Old Testament, New Testament, and
Apocrypha books that provide a framework from each book can be studied.

The One-Minute Bible for Windows - [Book Outline: Genesis]
¥Yiew “Window Help
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(Genesis

Four Specific Events — 1-11.26
Creation — 1.1-2 25
Fall—3.1-
Flood — B.




Go To Bible Text: Pressing this button will open a the Bible Study program that is
selected in the ToolBox for the selected book.



Go To Profile: Pressing this button will open a open a Profile window for the
selected book.



Go To Outline: Pressing this button will open a Outline window for the selected
book.



Drop-down Box: This drop-down box allows you to select any other book of the
Bible or Apocrypha.
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OMBW has provided a Profile of each book of the Old Testament, New Testament,
and Apocrypha. The Profile provides you with an Introduction to the book that often

includes some important topic covered in the book, an Expanded Outline, and a
Thought to Contemplate.

To See a Book Profile

% Choose the book by clicking on the book.

Select the Book Overview button from the MenuBar. and choose
Book Profile and OMBW open a Profile window of the book you

have chosen. You may move from the Profile to the Outline by
pressing the Outline button.

Or select View from the MenuBar and choose Profile.

Press ALT + P.




There are Book Profiles for the Old Testament, New Testament, and Apocrypha.
These include an extended outline which you can print by pressing the print button.
The One-Minute Bible for Windows - [Book Profile: Gene
=| File Edit Yiew Yindow Help
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(Genesis

Autheor: Traditionally Moses

Focal Point: Beginnings

Introduction



The Book Outlines and Profiles were written to help you get a quick overview of the
books of the Old Testament, New Testament, and Apocrypha. The outlines do not
follow the traditional outline form. They are outlined with acrostics or alliteration to
help readers commit the outlines to memory if they choose. The Profiles include an
introduction along with some explanation of special information within the book,
such as the list of the Works of the Flesh and Fruit of the Spirit in the Profile of
Galatians. There is also an expanded outline and a thought to contemplate. These
Outlines and Profiles will help you begin nibbling on the Word. They are intended to
make you hungry for more in-depth study of Scripture.



The MenuBar in OMBW lists the available menus from which you may choose
program functions. When you click your mouse pointer on a selection on the

MenuBar, a drop-down menu appears. A menu contains a list of commands you may
ask OMBW to carry out.

See Also:
Window



The Window Menu in the Almanac View displays all the active windows you have
opened while working in the Almanac View.

To Move From Window To Window
Select Window from the MenuBar.

Choose the window to which you wish to move. The Active window has
a check mark before it.

Or press the number reference that corresponds to the desired
window.



Logos Research Systems, Inc., offers you FREE product support by phone. But,
before calling you should try to solve your problem using the Online User's Guide. If
this is unsuccessful, you may call and talk with a product support person.

You may reach Logos Product Support between 8:00 A.M. and 5:00 P.M. Pacific time,
Monday through Friday.

For assistance with The One Minute Bible for Windows, call (206) 679-4496.

When you call, you should be at your computer, if possible. Please be prepared to
give the following information:
—  Theversion and revision number that you are using. You may find this
information in the Help menu. Select Help and choose About.
—  The type of hardware you are using, including network hardware, if
applicable.
—  The exact wording of any messages that appeared on your screen.
— Adescription of what happened and what you were doing when the
problem occurred.

How you tried to solve the problem.
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Almanac View
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Bible Book Index
Book Outline
Book Profile
Book View
BookMark
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Category
Chronological Order
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Date Finder
Drag and Drop
H

HotKey
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Link

@ Almanac View
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Map Locator
MenuBar

N

NotePad
NoteTracker
R

Related Texts
S

SlideBar

T

TimeLine ToolBar
ToolBar
Topical Index
Topical Order
U

Unlink

w
WORDMarker
WORDMarker Search
WorkSet

The Almanac View allows you to work with the additional study material within
OMBW, such as book outlines and book profiles.



Bible Book Index

You gain access to the 366 Daily Reading subjects in OMBW by using the Bible Book
Index.



Book Outline

A Book Outline of each of the books of the Old Testament, New Testament, and
Apocryphal is provided.



Book Profile

A Profile of each of the Old Testament, New Testament, and Apocryphal books is
given with an Introduction, Key Information within the book, an Expanded Outline,
and a Thought To Contemplate.



_ Book View

The Book View is the initial window for The One-Minute Bible for Windows. It is
composed of three sections: the MenuBar across the top of the window, the ToolBar to the
left or right of the window, and the Daily Reading selection from the New International
Version or King James Version of the Bible. From this view you may read the Scripture text
and select any of this view's features from the MenuBar or the ToolBar.



BookMark

You can set up to ten BookMarks in OMBW that allow you instant access to special
places you want to return to over and over.



Category

There are three Categories of books in the Almanac View: Old Testament, New
Testament, and Apocrypha.



Chronological Order

The Chronological Order of the Old Testament by its story line, the chronology of the
New Testament and Apocryphal books by their date of writing can be viewed.



Date Finder

The Date Finder allows you to move instantly to any calendar date.



Drag and Drop

Select text in the Book View by clicking on the left mouse button. While holding down the
button drag the mouse point to the Printer or Clipboard buttons, and drop the text by
releasing release the mouse button.



HotKey

HotKeys are keyboard keystrokes you can use to request certain actions within
OMBW. For example, if you press ALT + A while in the Book View, you open a
window called the Almanac_View.



Link

This links the TimeLine information to the books of the Old Testament, New Testament, and
Apocrypha.



Map Locator

The One-Minute Bible for Windows is packaged with seven Bible land maps. The Map
Locator helps you select the map that is of interest to you.



MenuBar

The MenuBar lists the available menus from which you may choose OMBW features. Click
the mouse pointer on a MenuBar word and a drop-down menu of choices will appear. Make a
selection and OMBW will perform the function.



NotePad

Pressing the NotePad Button will launch OMBW's NoteTracker, Windows' Notepad, or
your favorite word processor. You can set your choice in the ToolBox.



Related Texts

Every Daily Reading has a group of Related Texts associated with it. These text will expand
on the Daily Reading topic. There are over 1800 text references. You can read the passage if
you have a compatible Windows Bible Study already setup in the ToolBox by pressing the
Related Texts button and double-clicking on a reference.



SlideBar

A part of the TimeLine ToolBar. You can drag the SlideBar to different periods of
time. As you drag, you can see the time periods being reflected in the time period

view box on the same ToolBar.



TimelLine ToolBar

The TimeLine ToolBar is accessed by choosing the TimeLine Button on the ToolBar in
the Almanac View. When the TimeLine ToolBar is activated, you may view history
from twenty-nine different time periods.



ToolBar

There are three main ToolBars in OMBW. The first is in the Book View and appears on the left
side of your screen. The second is in the Almanac View and appears across the top of your
screen. The third also appears in the Almanac View and toggles on and off by pressing the
TimeLine button. In addition, there smaller ToolBars on other windows throughout OMBW.



Topical Index

Over 450 topics and personalities are referenced in this index. They are indexed in
alphabetical order. You can choose any topic from the index and press the Go To button to
move to the requested topic.



Topical Order
The Topical Order demonstrates the major kinds of literature in the Old Testament, New
Testament, and Apocrypha. Knowing the kind of literature you are reading can help you in
your reading and understanding of Scripture.



Unlink

This unlinks the TimeLine from the books of the Old Testament, New Testament, and
Apocrypha.



WORDMarker

Logos Research Systems, Inc., has developed a new technology we call
WORDMarker. OMBW has four color WORDMarkers that you may use to highlight
text in the Book View.



WORDMarker Search

The WORDMarker Search function searches for any color you have used to highlight texts in
a WorkSet.



WorkSet

A WorkSet is the work you have done in an OMBW during the time the program is running.
For example, the colors, the BookMarks and Notes you have used or made. When you Exit
OMBW, the WorkSet will be saved and you may open it at a future time using File Open.






NoteTracker

The new NoteTracker feature in OMBW has the traditional features of a notepad plus the
ability to link notes to a Daily Reading.



The Almanac (ALT + A): When you press the Almanac button, you will move to
the Almanac View of The One-Minute Bible for Windows. This view allows you to
work with the added study materials such as book outlines and book profiles.



Bible Version: Press this button to toggle between King James and the New
International Version of the Bible in the Book View window.



Topical Index (ALT + T): Pressing the Topical Index button gives you a dialog box
where you may choose from more than 450 topics and personalities found in the
text of OMBW.



Biblical Book Index (ALT + 1): Pressing the Biblical Book Index button will provide
you with an index of all the daily subjects covered by OMBW.



Related Texts: Pressing the Related Texts button will allow you to view the Related
Texts to the daily reading.



Date Finder (ALT + D): Pressing the Date Finder button will provide a dialog box
where you may select any date and OMBW will move you to your selection.



WORDMarker Search (ALT + S): Pressing the WORDMarker Search button will
bring a dialog box from which you can choose the color for which you would like to
search.



Map Locator (ALT + M): Press the Map Locator button and select from any of
seven maps.



NoteTracker (ALT + N): Press the NoteTracker button and you will be able to
record and link information.



BookMark (ALT + K): Press the BookMark button and set up to ten BookMarks that
mark daily readings for easy access.



WORDMarker: Press the color WORDMarker of your choice to mark your daily
reading.



WORDMarker Palette: Pressing the WORDMarker Palette button opens a small
window that shows you the names you have assigned to the colors in the current
WorkSet.



File Open (CTRL + O): Press the File Open button to see a list of the files in which
you have saved your WORDMarker and BookMark data.



Erase WORDMarker: Pressing the Erase WORDMarker button will allow you to
erase any of the highlights you have placed in your daily readings.



Printer (CTRL + P): Press the Printer button to print a Daily Reading or press the
left mouse button on the Daily Reading page, drag and drop on the Printer button
for printing.



Clipboard: Press the Clipboard button to store a temporary text you wish to use
in another Windows application.



ToolBox: Press the ToolBox button and set up your preferences.



The Book (ALT + B): Press The Book button to return from the Almanac View to
the Book View.



File Open (CTRL + O): Press the File Open button to see a list of the files where
you have saved your WORDMarker and BookMark data.



Printer (CTRL + P): Press the Printer button to print a Daily Reading or press the
left mouse button on the Daily Reading page. Drag and drop on the Printer button
for printing.



NotePad (ALT + N): Press the NotePad and you will be able to record information.



Bible Order (CTRL +B): Pressing the Bible Order will display the books of the Old
Testament, New Testament, or the Apocrypha in the order you find them in a printed
Bible.



Overview: Pressing the Overview button provides you with an overview of the
book which you have chosen.



Chronological Order (CTRL + C): Pressing the Chronological Order button will
display the Old Testament, New Testament, or the Apocrypha in its chronological
order.



Overview: Pressing the Overview button provides you with an overview of the
Chronological Order.



Topical Order (CTRL + T): Pressing the Topical Order button will display the Old
Testament, New Testament, or the Apocrypha according to the kind of literature
within each category.



Overview: Pressing the Overview button provides you with an overview of the
Chronological Order.



TimeLine (CTRL + L): Pressing the TimeLine button will display the TimeLine
ToolBar from which you may select and view twenty-nine summaries of Biblical and
World History.



Next Period: Press the Next Period button to move you to the next historical
period.



Previous Period: Press the Previous Period button to move to the previous
historical period.



TimelLine Link: Press the TimeLine Link button to link the time period to the
selected book.



TimelLine Unlink: Press the TimeLine Unlink button to unlink the time period from
the selected book.



Map Locator (ALT + M): Press the Map Locator button and select from any of
seven maps.



Book Outline (ALT + B): Pressing the Book Outline button will display the selected
book's outline.



Book Profile (ALT + P): Pressing the Book Profile button will display the selected
book's profile.



Minimize Button: Press this button and the palette will scroll up into a small
palette which you can move to any part of your window and reopen at a later time.



Present Search Color: The color of this bar represents the color you ask OMB to
search for. It will change as you change your request.



Topics: This area displays the topics which have been marked by you and have
been found in the search.



Blue WORDMarker: Press the Blue WORDMarker to search for your blue markings.



Green WORDMarker: Press the Green WORDMarker to search for your green
markings.



Red WORDMarker: Press the Red WORDMarker to search for your red markings.



Yellow WORDMarker: Press the Yellow WORDMarker to search for your yellow
markings.



Go To Button: Highlight a topic you wish to review and press this button to go
there.



Exit Button: Press the exit button to exit the color palette.



Help Button: Press the help button to receive help for the WORDMarker Palette.



Maximize Button: Press this button to maximize the WORDMarker Palette.



Help: Press this button to receive context-sensitive help.



a Book View

The Book View is the main view that you enter when you start OMBW.
To Return to the Book View
% Select the Book View button from the ToolBar.
Or select View from the MenuBar and choose the Book.

Press ALT + B.

Press your Right Mouse button on any book in the Almanac View to see a pop-up
menu with four selections. You may:

Read the book you have highlighted in the Bible.

View the book you have highlighted.

Print the book you have highlighted.

View an outline of the book you have highlighted.



Click your Right Mouse button over any highlighted book and a pop-up menu
appears.
= [} e Bible fo do . ana

=( File Edit Yiew Window Help

q@ The New Testament|* rﬁfdﬁjl ﬁ @

d this book in the Bible
View a profile of this book
Print a profile of this book
View an outline of this book




Read This Book in the Bible: Press this selection to open the Bible Study program
that you have selected in the ToolBox to the first chapter and first verse of the
selected book showing.



View A Profile of this Book: Press this selection to see the Book Profile for the
selected book.



Print a Profile of this Book: Press this button to print the Book Profile for the
selected book.



View an Outline of this Book: Press this button to see the Book Outline for the
selected book.



Pointer & Book: When you move your mouse over the books, the mouse pointer
changes to a pointer-with-a-book. Double-click your left mouse button to open the
Bible Study program that you have selected in the ToolBox to the first chapter and
first verse of the selected Book. Click your Right Mouse button once and the Pop-up
menu appears and the pointer changes from the pointer-with-a-book back to its
regular pointer.



File Save: Press this button to name and save the WorkSet you have opened or
started.






